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Introduction SOLIDWORKS Education 2023
To the Teacher The SOLIDWORKS Education Edition - Fundamentals of 3D Design 
and Simulation manual is designed to assist you in teaching 
SOLIDWORKS and SOLIDWORKS Simulation in an academic 
setting. This guide offers a competency-based approach to teaching 3D 
design concepts, analysis and techniques.

Qualified schools on subscription have access to the eBook at no cost 
to students. Contact your SOLIDWORKS Value Added Reseller to 
obtain access. 

SOLIDWORKS 
Tutorials

The SOLIDWORKS Education Edition 
- Fundamentals of 3D Design and 
Simulation manual also supplements 
the SOLIDWORKS Tutorials.

Accessing the 
SOLIDWORKS 
Tutorials

To start the SOLIDWORKS Tutorials, click Help, SOLIDWORKS 
Tutorials. The SOLIDWORKS window is resized and a second 
window appears next to it with a list of the available tutorials. There are 
over 40 lessons in the SOLIDWORKS Tutorials. As you move the 
pointer over the links, an illustration of the tutorial will appear at the 
bottom of the window. Click the desired link to start that tutorial.

TIP: When you use SOLIDWORKS Simulation to perform analysis, 
click Help, SOLIDWORKS Simulation, Tutorials to access 
over 50 lessons and over 80 verification problems. Click 
Tools, Add-ins to activate SOLIDWORKS Simulation, 
SOLIDWORKS Motion, and SOLIDWORKS Flow 
Simulation.
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SOLIDWORKS Education 2023 Introduction
Conventions Set your screen resolution to 1280x1024 for optimal viewing of the 
tutorials.

The following icons appear in the tutorials:

Moves to the next screen in the tutorial.

Represents a note or tip. It is not a link; the information is below 

the icon. Notes and tips provide time-saving steps and helpful hints.

You can click most buttons that appear in the lessons to flash the 
corresponding SOLIDWORKS button.

Open File or Set this option automatically opens the file or sets 
the option.

A closer look at... links to more information about a topic. 
Although not required to complete the tutorial, it offers more detail on 
the subject.

Why did I... links to more information about a procedure, and 
the reasons for the method given. This information is not required to 
complete the tutorial.

Show me... demonstrates with a video.

Printing the 
SOLIDWORKS 
Tutorials

If you like, you can print the SOLIDWORKS Tutorials by following 
this procedure:

1. On the tutorial navigation toolbar, click Show.

This displays the table of contents for the SOLIDWORKS 
Tutorials.

2. Right-click the book representing the lesson you wish to print and 
select Print... from the shortcut menu.

The Print Topics dialog box appears.

3. Select Print the selected heading and all subtopics, and click 
OK.

4. Repeat this process for each lesson that you want to print.
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Introduction SOLIDWORKS Education 2023
My SOLIDWORKS My.SolidWorks.com is a community website to share, connect, and 
learn everything about SOLIDWORKS. My SOLIDWORKS learning 
contains additional video lessons and individual learning paths for your 
students.

Certification 
Exams

The Certified SOLIDWORKS Associate(CSWA) - Academic program 
provides free certification exams for you or your students in a 
proctored setting. Achieving CSWA proves the fundamentals of 
engineering design competency. Employers verify students job ready 
credentials through our online virtual tester. Schools that provide two 
or more courses in SOLIDWORKS-based instruction can also apply to 
be a Certified SOLIDWORKS Professional(CSWP) - Academic 
Provider.

More information and to apply can be found at 
www.solidworks.com/cswa-academic.

Training Files A complete set of the various files used throughout the course can be 
downloaded from the following website:
www.solidworks.com/EDU_Fundamentals3DDesignSim

The files are organized by lesson number. The Case Study folder 
within each lesson contains the files you need when presenting the 
lessons. The Exercises folder contains any files that are required for 
doing the laboratory exercises.

Educator 
Resources link

The Instructors Curriculum link on the SOLIDWORKS Resources 
 tab of the Task Pane includes substantial supporting materials to aid 

in your course presentation. Accessing this page requires a login 
account for the SOLIDWORKS Customer Portal. These supporting 
materials afford you flexibility in scope, depth, and presentation.

1. Start SOLIDWORKS.

Using the Start menu, start the SOLIDWORKS application.

2. SOLIDWORKS Content.

Click SOLIDWORKS Resources  to 
open the SOLIDWORKS Resources Task 
Pane.

Click on the Instructors Curriculum link 
which will take you to the 
SOLIDWORKS Customer Portal web 
page.NOT F
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SOLIDWORKS Education 2023 Introduction
Prerequisites Students attending this course are expected to have the following:

 Mechanical design experience.

 Experience with the Windows® operating system.
 Completed the online tutorials that are integrated in the 

SOLIDWORKS software. You can access the online tutorials by 
clicking Help, Online Tutorial.

Course Design 
Philosophy

This course is designed around a process- or task-based approach to 
training. A process-based training course emphasizes the processes and 
procedures you follow to complete a particular task. By utilizing case 
studies to illustrate these processes, you learn the necessary commands, 
options and menus in the context of completing a task.

A Note About 
Dimensions

The drawings and dimensions given in the lab exercises are not intended 
to reflect any particular drafting standard. In fact, sometimes dimensions 
are given in a fashion that would never be considered acceptable in 
industry. The reason for this is the labs are designed to encourage you to 
apply the information covered in class and to employ and reinforce 
certain techniques in modeling. As a result, the drawings and dimensions 
in the exercises are done in a way that complements this objective.

Conventions Used 
in this Book

This manual uses the following typographic conventions:

Windows The screen shots in this manual were made using the SOLIDWORKS 

software running a mixture of Windows® 7 and Windows 10. You may 
notice slight differences in the appearance of the menus and windows. 
These differences do not affect the performance of the software.

Convention Meaning

Bold Sans Serif SOLIDWORKS commands and options 
appear in this style. For example, Features > 

Extruded Cut  means click the Extruded 
Cut icon on the Features tab of the 
CommandManager.

Typewriter Feature names and file names appear in this 
style. For example, Sketch1.

17 Do this step

Double lines precede and follow sections of 
the procedures. This provides separation 
between the steps of the procedure and large 
blocks of explanatory text. The steps 
themselves are numbered in sans serif bold.
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Introduction SOLIDWORKS Education 2023
Use of Color The SOLIDWORKS user interface makes extensive use of color to 
highlight selected geometry and to provide you with visual feedback. 
This greatly increases the intuitiveness and ease of use of the 
SOLIDWORKS software. To take maximum advantage of this, the 
training manuals are printed in full color.

Also, in many cases, we have used 
additional color in the illustrations to 
communicate concepts, identify 
features, and otherwise convey 
important information. For example, 
we might show the result of a filleting 
operation with the fillets in a different 
color even though, by default, the 
SOLIDWORKS software would not display the results in that way.

Graphics and 
Graphics Cards

 The SOLIDWORKS software sets a new 
standard with best-in-class graphics. The 
combination of a highly reflective 
material and the realism of RealView 
Graphics is an effective tool for 
evaluating the quality of advanced part 
models and surfaces.

RealView Graphics is hardware 
(graphics card) support of advanced 
shading in real time. For example, if you 
rotate a part, it retains its rendered appearance throughout the rotation.

Color Schemes Out of the box, the SOLIDWORKS software provides several 
predefined color schemes that control, among other things, the colors 
used for highlighted items, selected items, sketch relation symbols, and 
shaded previews of features.

We have not used the same color scheme for every case study and 
exercise because some colors are more visible and clear than others 
when used with different colored parts. 

In addition, we have changed the viewport background to plain white 
so that the illustrations reproduce better on white paper.

As a result, because the color settings on your computer may be 
different than the ones used by the authors of this book, the images you 
see on your screen may not exactly match those in the book.

User Interface 
Appearance

Throughout the development of the software, there have been some 
cosmetic User Interface changes, intended to improve visibility, that do 
not affect the function of the software. As a policy, dialog images in the 
manuals which exhibit no functional change from the previous version 
are not replaced. As such, you may see a mixture of current and “old” 
UI dialogs and color schemes.
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Lesson 1
SOLIDWORKS Basics and the

User Interface

Upon successful completion of this lesson, you will be able to:

 Describe the key characteristics of a feature-based, parametric solid 
modeler.

 Distinguish between sketched and applied features.

 Identify the principal components of the SOLIDWORKS user 
interface.

 Explain how different dimensioning methodologies convey 
different design intents.
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Lesson 1 SOLIDWORKS Education 2023
SOLIDWORKS Basics and the User Interface
What is the 
SOLIDWORKS 
Software?

SOLIDWORKS mechanical design automation software is a feature-
based, parametric solid modeling design tool which takes advantage of 
the easy to learn Windows graphical user interface. You can create fully 
associative 3D solid models with or without constraints while utilizing 
automatic or user defined relations to capture design intent.

The italicized terms in the previous paragraph mean:

 Feature-based
Just as an assembly is made up of a number of individual piece parts, a 
SOLIDWORKS model is also made up of individual constituent 
elements. These elements are called features.

When you create a model using the SOLIDWORKS software, you 
work with intelligent, easy to understand geometric features such as 
bosses, cuts, holes, ribs, fillets, chamfers, and drafts. As the features are 
created they are applied directly to the work piece.

Features can be classified as either sketched or applied.

 Sketched Features: Based upon a 2D sketch. Generally that sketch 
is transformed into a solid by extrusion, rotation, sweeping or 
lofting.

 Applied Features: Created directly on the solid model. Fillets and 
chamfers are examples of this type of feature.

The SOLIDWORKS software graphically shows you the feature-based 
structure of your model in a special window called the 
FeatureManager® design tree. The FeatureManager design tree not only 
shows you the sequence in which the features were created, it gives you 
easy access to all the underlying associated information. You will learn 
more about the FeatureManager design tree throughout this course.

To illustrate the concept of feature-
based modeling, consider the part 
shown at the right:

This part can be visualized as a 
collection of several different 
features – some of which add 
material, like the cylindrical boss, 
and some which remove material, 
like the blind hole.NOT F
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SOLIDWORKS Education 2023 Lesson 1
SOLIDWORKS Basics and the User Interface
If we were to map the individual features to their corresponding listing 
in the FeatureManager design tree, it would look like this:

 Parametric
The dimensions and relations used to create a feature are captured and 
stored in the model. This not only enables you to capture your design 
intent, it also enables you to quickly and easily make changes to the 
model.

 Driving Dimensions: These are the dimensions used when creating 
a feature. They include the dimensions associated with the sketch 
geometry, as well as those associated with the feature itself. A 
simple example of this would be a feature like a cylindrical boss. 
The diameter of the boss is controlled by the diameter of the 
sketched circle. The height of the boss is controlled by the depth to 
which that circle was extruded when the feature was made.

 Relations: These include such information as parallelism, tangency, 
and concentricity. Historically, this type of information has been 
communicated on drawings via feature control symbols. By 
capturing this in the sketch, SOLIDWORKS enables you to fully 
capture your design intent up front, in the model.

 Solid Modeling
A solid model is the most complete type of geometric model used in 
CAD systems. It contains all the wire frame and surface geometry 
necessary to fully describe the edges and faces of the model. In addition 
to the geometric information, it has the information called topology that 
relates the geometry together. An example of topology would be which 
faces (surfaces) meet at which edge (curve). This intelligence makes 
operations such a filleting as easy as selecting an edge and specifying a 
radius.
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Lesson 1 SOLIDWORKS Education 2023
SOLIDWORKS Basics and the User Interface
 Fully Associative
A SOLIDWORKS model is fully associative to the drawings and 
assemblies that reference it. Changes to the model are automatically 
reflected in the associated drawings and assemblies. Likewise, you can 
make changes in the context of the drawing or assembly and know that 
those changes will be reflected back in the model.

 Constraints
Geometric relationships such as parallel, perpendicular, horizontal, 
vertical, concentric, and coincident are just some of the constraints 
supported in SOLIDWORKS. In addition, equations can be used to 
establish mathematical relationships among parameters. By using 
constraints and equations, you can guarantee that design concepts such 
as through holes or equal radii are captured and maintained.

 Design Intent
The final italicized term is design intent. This subject is worthy of its 
own section, as follows.

Design Intent In order to use a parametric modeler like SOLIDWORKS efficiently, 
you must consider the design intent before modeling. Design intent is 
your plan as to how the model should behave when it is changed. The 
way in which the model is created governs how it will be changed. 
Several factors contribute to how you capture design intent:

 Automatic (sketch) Relations
Based on how geometry is sketched, these relations can provide 
common geometric relationships between objects such as parallel, 
perpendicular, horizontal, and vertical.

 Equations
Used to relate dimensions algebraically, they provide an external way 
to force changes.

 Added Relations
Added to the model as it is created, relations provide another way to 
connect related geometry. Some common relations are concentric, 
tangent, coincident, and collinear.

 Dimensioning
Consider your design intent when applying dimensions to a sketch. 
What are the dimensions that should drive the design? What values are 
known? Which are important for the production of the model? The way 
dimensions are applied to the model will determine how the geometry 
will change if modifications are made.

Consider the design intent in the following examples.NOT F
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SOLIDWORKS Education 2023 Lesson 1
SOLIDWORKS Basics and the User Interface
Examples of 
Design Intent

The design intent of each sketch below is slightly different. How will 
the geometry be affected if the overall plate width, 100mm, is 
changed? 

A sketch dimensioned like this will keep 
the holes 20mm from each end regardless 
of the width of the plate. 

Baseline dimensions like this will keep the 
holes positioned relative to the left edge of 
the plate. The positions of the holes are not 
affected by changes in the overall width of 
the plate.

Dimensioning from the edge and from 
center to center will maintain the distance 
between the hole centers and allow it to be 
changed that way. 

How Features 
Affect Design 
Intent

Design intent is affected by more than just 
how a sketch is dimensioned. The choice of 
features and the modeling methodology are 
also important. For example, consider the 
case of a simple stepped shaft as shown at 
the right. There are several ways a part like 
this could be built and each way creates a 
part that is geometrically identical.

The “Layer Cake” 
Approach

The layer cake approach builds the part one piece at a time, adding each 
layer, or feature, onto the previous one, like this:

Changing the thickness of one layer has a ripple effect, changing the 
position of all the other layers that were created after it.
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Lesson 1 SOLIDWORKS Education 2023
SOLIDWORKS Basics and the User Interface
The “Potter’s 
Wheel” Approach

The potter’s wheel approach builds the part as 
a single, revolved feature. A single sketch 
representing the cross section includes all the 
information and dimensions necessary to make 
the part as one feature. While this approach 
may seem very efficient, having all the design 
information contained within a single feature 
limits flexibility and can make changes awkward.

The Manufacturing 
Approach

The manufacturing approach to modeling mimics the way the part 
would be manufactured. For example, if this stepped shaft was turned 
on a lathe, you would start with a piece of bar stock and remove 
material using a series of cuts.

There is not really a right or wrong answer when trying to determine 
which approach to use. SOLIDWORKS allows for great flexibility and 
making changes to models is relatively easy. But creating models with 
design intent in mind will result in well built documents that are easily 
modifiable and well suited for re-use, making your job easier.

File References SOLIDWORKS creates files that are compound documents that 
contain elements from other files. File references are created by linking 
files rather than duplicating information in multiple files.

Referenced files do not have to be stored with the document that 
references them. In most practical applications, the referenced 
documents are stored in multiple locations on the computer or network. 
SOLIDWORKS provides several tools to determine the references that 
exist and their location.
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SOLIDWORKS Education 2023 Lesson 1
SOLIDWORKS Basics and the User Interface
Object Linking and 
Embedding (OLE)

In the Windows environment, information sharing between files can be 
handled either by linking or embedding the information.

The main differences between linked objects and embedded objects are 
where the data is stored and how you update the data after you place it 
in the destination file.

Linked Objects When an object is linked, information is updated only if the source file 
is modified. Linked data is stored in the source file. The destination file 
stores only the location of the source file (an external reference), and it 
displays a representation of the linked data. 

Linking is also useful when you want to include information that is 
maintained independently, such as data collected by a different 
department.

Embedded Objects When you embed an object, information in the destination file doesn't 
change if you modify the source file. Embedded objects become part of 
the destination file and, once inserted, are no longer part of the source 
file.

File Reference 
Example

The many different types of external references created by 
SOLIDWORKS are shown in the following graphic. Some of the 
references can be linked or embedded. 
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Lesson 1 SOLIDWORKS Education 2023
SOLIDWORKS Basics and the User Interface
Opening Files SOLIDWORKS is a RAM-resident CAD system. Whenever a file is 
opened, it is copied from its storage location to the computer’s Random 
Access Memory or RAM. All changes to the file are made to the copy 
in RAM and only written back to the original files during a Save 
operation.

Computer Memory To better understand where files are stored and which copy of the file 
we are working on, it is important to differentiate between the two main 
types of computer memory.

Random Access 
Memory

Random Access Memory (RAM) is the volatile memory of the 
computer. This memory only stores information when the computer is 
operating. When the computer is turned off, any information in RAM is 
lost.

Fixed Memory Fixed memory is all the non-volatile memory. This includes computer 
hard drives, flash drives and CD/DVD drives. Fixed memory holds its 
information even when the computer is not running.

Save

Open

Fixed Disk
RAM
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SOLIDWORKS Basics and the User Interface
The 
SOLIDWORKS 
User Interface

The SOLIDWORKS user interface is a native Windows interface, and 
as such behaves in the same manner as other Windows applications. 
Some of the more important aspects of the interface are identified 
below.

Welcome Dialog 
Box

The Welcome dialog box opens with SOLIDWORKS to provide 
convenient ways to create new documents, open existing documents, 
and access SOLIDWORKS resources and news.

Note This dialog box can also be set to Do not show on startup.

Graphics Area

Document Window Reference Triad

CommandManager Tabs

FeatureManager
design tree

Status Bar

Task Pane

Heads-up

Menu Bar pull-downs

View Toolbar
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Lesson 1 SOLIDWORKS Education 2023
SOLIDWORKS Basics and the User Interface
Pull-down Menus The Pull-down menus provide access to many of the commands that 
the SOLIDWORKS software offers. Float over the right facing arrow 
to access the menus. Click the pushpin to keep the menus open. 

When a menu item has a right-pointing 

arrow like this: , it 
means that there is a sub-menu associated 
with that choice.

When a menu item is followed by ellipses 

like this: , it means 
that the option opens a dialog box with 
additional choices or information.

Customizing 
Pull-down Menus

When the Customize Menu item is selected, each 
item appears with a check box. Clearing the check 
box removes the associated item from the menu.

Using the 
Command 
Manager

The CommandManager is a set of icons divided into tabs that are 
geared towards specific tasks. For example, the part version has several 
tabs to access commands related to features, sketches, and so on.

Note The CommandManager can be displayed with or without text on the 
buttons. These images show the Use Large Buttons with Text option. 
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Adding and 
Removing 
CommandManager 
Tabs

The default settings display multiple CommandManager tabs for a part 
file. Others can be added or removed by right-clicking on any tab, 
clicking Tabs, and clicking or clearing the tab by name. 

There are different sets of tabs for part, assembly and drawing files. 

FeatureManager 
Design Tree

The FeatureManager design 
tree is a unique part of the 
SOLIDWORKS software 
that visually displays all the 
features in a part or 
assembly. As features are 
created they are added to the 
FeatureManager design tree. 
As a result, the 
FeatureManager design tree 
represents the chronological 
sequence of modeling 
operations. The 
FeatureManager design tree 
also allows access to the 
editing of the features 
(objects) that it contains.

FeatureManager Design Tree
PropertyManager

ConfigurationManager

Hide/
Show
FM

DimXpertManager

Hide/
Show
Display
Pane

DisplayManager
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SOLIDWORKS Basics and the User Interface
Show and Hide 
FeatureManager 
Items

Many FeatureManager items (icons and folders) are hidden by default. 
In the image above, only the History, Sensors and Annotations 
folders are shown. 

Click Tools, Options, System Options, and FeatureManager to 
control their visibility using one of the three settings explained below. 

 Automatic - Hide the item when it is empty. 
 Hide - Hide the item at all times. 
 Show - Show the item at all times. 

Tip The CommandManager or PropertyManager can be dragged and 
docked on the top, side or outside of the SOLIDWORKS window or to 
a different monitor. 
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SOLIDWORKS Basics and the User Interface
PropertyManager Many SOLIDWORKS commands are executed through the 
PropertyManager. The PropertyManager occupies the same screen 
position as the FeatureManager design tree and replaces it when it is in 
use.

The top row buttons contain the 
standard OK and Cancel buttons. 

Below the top row of buttons are 
one or more Group Boxes that 
contain related options. They can 
be opened (expanded) or closed 
(collapsed) and in many cases 
made active or inactive.

Full Path Name The full path name of the document can be 
seen as a tool tip when floating the cursor over 
the file name.

Selection 
Breadcrumbs

Selection Breadcrumbs show the 
hierarchy of objects based on a selected 
piece of geometry. For example, selecting 
a face can lead to a series of objects 
including the feature, sold body, component, subassembly, and finally 
to the top level assembly. 

It also leads to the sketch of the feature and the mates attached to that 
component. 

These visual objects can also be used for access. Right-clicking on the 
boss feature offers several editing tools including Edit Feature and 
Hide.

Note These objects and tools will be discussed in later lessons.

Group Box

Open and active

Open and

Close icon

Cancel
OK

Group Box

Closed and inactive
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Lesson 1 SOLIDWORKS Education 2023
SOLIDWORKS Basics and the User Interface
Task Pane The Task Pane window contains SOLIDWORKS Resources , 

Design Library , File Explorer , View Palette , 

Appearances, Scenes, and Decals , and Custom Properties  
options. The window appears on the right by default but it can be 
moved and resized. It can be opened/closed, tacked or moved from its 
default position on the right side of the interface.
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SOLIDWORKS Education 2023 Lesson 1
SOLIDWORKS Basics and the User Interface
Opening Labs with 
the File Explorer

You can open parts and assemblies 
required for lab exercises using the File 
Explorer. 

 Open the Task Pane.

 Click File Explorer .
 Expand the Essentials folder used 

for the class files. It should be found 
under the SOLIDWORKS Training 
Files folder.

 Expand the lesson folder 
(Lesson01 for example) followed 
by either the Case Study or 
Exercises folder.

 Double-click a part or assembly file 
to open it.

Heads-up View 
Toolbar

The Heads-up View toolbar is a 
transparent toolbar that contains 
many common view manipulation 
commands. Many of the icons 
(such as the Hide/Show Items 
icon shown) are Flyout Tool 
buttons that contain other options. 
These flyouts contain a small 

down arrow  to access the other 
commands.

Unselectable 
Icons

At times you will notice commands, icons, and menu options that are 
grayed out and unselectable. This is because you may not be working in 
the proper environment to access those options. For example, if you are 
working in a sketch (Edit Sketch mode), you have full access to all the 
sketch tools. However, you cannot select the icons such as fillet or 
chamfer on the Features tab of the CommandManager. This design 
helps the inexperienced user by limiting the choices to only those that 
are appropriate.NOT F
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Lesson 1 SOLIDWORKS Education 2023
SOLIDWORKS Basics and the User Interface
To Preselect or Not? As a rule, the SOLIDWORKS software does not require you to 
preselect objects before opening a menu or dialog box. For example, if 
you want to add some fillets to the edges of your model, you have 
complete freedom – you can select the edges first and then click the 
Fillet tool or you can click the Fillet tool and then select the edges. The 
choice is yours.

Mouse Buttons The left, right and middle mouse buttons have distinct meanings in 
SOLIDWORKS.

 Left
Select objects such as geometry, menus buttons, and objects in the 
FeatureManager design tree.

 Right
Activates a context sensitive shortcut menu. The contents of the menu 
differ depending on what object the cursor is over. These menus also 
represent shortcuts to frequently used commands.

Shortcut Menu At the top of the Shortcut Menu is the 
Context Toolbar. It contains some of the most 
commonly used commands in icon form.

Below it is the pull-down menu. It contains 
other commands that are available in the 
context of the selection, in this example a face.

Note The Context toolbar will also become available as you make selections 
with the left mouse button. It provides quick access to common 
commands.

 Middle
Dynamically rotates, pans or zooms a part or assembly. Pans a drawing.

Keyboard 
Shortcuts

Some menu items indicate a keyboard shortcut like this: 

 

SOLIDWORKS conforms to standard Windows conventions for such 
shortcuts as Ctrl+O for File, Open; Ctrl+S for File, Save; Ctrl+Z for 
Edit, Undo and so on. In addition, you can customize SOLIDWORKS 
by creating your own shortcuts.
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Multiple Monitor 
Displays

SOLIDWORKS can take advantage of multiple monitor displays to 
span monitors and to move document windows or menus to a different 
monitor. 

Spanning Monitors Click Span Displays  on the top bar of the SOLIDWORKS window 
to stretch the display across both monitors. 

Fitting to a Monitor Click either Click to Tile Left  or Click to Tile Right  on the top bar 
of a document to fit it to the left or right monitor. 

System Feedback Feedback is provided by a symbol attached to the 
cursor arrow indicating what you are selecting or 
what the system is expecting you to select. As the 
cursor floats across the model, feedback will come in 
the form of symbols, riding next to the cursor. The 
illustration at the right shows some of the symbols: 
vertex, edge, face and dimension. 

Vertex

Edge

Face

Dimension
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Options Located on the Tools menu, the Options dialog box enables you to 
customize the SOLIDWORKS software to reflect such things as your 
company’s drafting standards as well as your individual preferences 
and work environment.

Tip Use the search bar in the upper right of the Options dialog box to find 
system options and document properties. Type the label of the check 
box, radio button, or other option to locate the page where the option 
resides.
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Customization You have several levels of customization. They are:

 System options
The options grouped under the heading System Options are saved on 
your system and affect every document you open in your 
SOLIDWORKS session. System settings allow you to control and 
customize your work environment. For example, you might like 
working with colored viewport background. I don’t. Since this is a 
system setting, parts or assemblies opened on your system would have 
a colored viewport. The same files opened on my system would not.

 Document properties
These settings are applied to the individual document. For example, 
units, drafting standards, and material properties (density) are all 
document settings. They are saved with the document and do not 
change, regardless of whose system the document is opened on.

 Document templates
Document templates are pre-defined documents that were set up with 
certain specific settings. For example, you might want two different 
templates for parts. One with English settings such as ANSI drafting 
standards and inch units, and one with metric settings such as 
millimeters units and ISO drafting standards. You can set up as many 
different document templates as you need. They can be organized into 
different folders for easy access when opening new documents. You 
can create document templates for parts, assemblies, and drawings.

 Object
Many times the properties of an individual object can be changed or 
edited. For example, you can change the default display of a dimension 
to suppress one or both extension lines, or you can change the color of a 
feature.

Search The Search option can be used to find information from 
SOLIDWORKS Help, Commands, Files and Models on your system 
by searching for any part of the name (requires Windows Desktop 
Search engine), or MySolidWorks information. Search using this 
procedure:

 Choose which type of search you would like to do.
 Type a name or partial name into the Search box 

and click the search icon . 
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Lesson 2
Introduction to Sketching

Upon successful completion of this lesson, you will be able to:

 Create a new part.

 Insert a new sketch.

 Add sketch geometry.

 Establish sketch relations between pieces of geometry.

 Understand the state of the sketch.

 Extrude the sketch into a solid.

NOT F
OR P

RODUCTIO
27



Lesson 2 SOLIDWORKS Education 2023
Introduction to Sketching
2D Sketching This lesson introduces 2D sketching, the basis of modeling in 
SOLIDWORKS.

Sketches are used for all sketched features in SOLIDWORKS 
including:

 Extrusions  Revolves
 Sweeps  Lofts

The illustration below shows how a given sketch can form the basis of 
several different types of features.

In this lesson, only extruded features will be covered. The others will 
be covered in detail in later lessons or courses.

Stages in the 
Process

Every sketch has several characteristics that contribute to its shape, size 
and orientation.

 New part
New parts can be created in inch, millimeter or other units. Parts are 
used to create and hold the solid model.

 Sketches
Sketches are collections of 2D geometry that are used to create solid 
features.

 Sketch geometry
Types of 2D geometry such as lines, circles and rectangles that make 
up the sketch.

 Sketch relations
Geometric relationships such as horizontal and vertical are applied to 
the sketch geometry. The relations restrict the movement of the entities.

Extrude Revolve Sweep Loft
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 State of the sketch
Each sketch has a status that determines whether it is ready to be used 
or not. The state can be fully-, under- or over defined.

 Sketch tools
Tools can be used to modify the sketch geometry that has been created. 
This often involves trimming or extending entities.

 Extruding the sketch
Extruding uses the 2D sketch to create a 3D solid feature.

Procedure The process in this lesson includes sketching and extrusions. To begin 
with, a new part file is created.

Introducing: 
New Part

The New tool creates a new SOLIDWORKS document from a 
selection of part, assembly or drawing templates. There are several 
training templates in addition to the default ones. 

Where to Find It  Menu Bar: New 
 Menu: File, New
 Keyboard Shortcut: Ctrl+N

1 New part.

Click New  and click the Part_MM template from the Training 
Templates tab on the New SOLIDWORKS Document dialog box, and 
click OK.

The part is created with the settings of the template including the units. 
This part template uses millimeters as the units. You can create and 
save any number of different templates, all with different settings.
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Saving Files Saving files writes the file information in RAM to a location on a fixed 
disk. SOLIDWORKS provides three options for saving files. Each has 
a different effect on file references.

Save Copy the file in RAM to the fixed disk, leaving the copy in RAM open. 
If this file is being referenced by any open SOLIDWORKS files, there 
are no changes to the reference.

Where to Find It  Menu Bar: Save 
 Menu: File, Save
 Keyboard Shortcut: Ctrl+S

Save As Copy the file in RAM to the fixed disk under a new name or file type, 
replacing the file in RAM with the new file. The old file in RAM is 
closed without saving. If this file is being referenced by any open 
SOLIDWORKS files, you should update the references to this new file.

Save As Copy to 
Disk

Copy the file in RAM to the fixed disk under a new name or file type, 
leaving the original in RAM open. If this file is being referenced by any 
open SOLIDWORKS files, you should not update the references to this 
new file.

Save As Copy and 
Open

Copy the file in RAM to the fixed disk under a new name or file type, 
leaving both the copy and the original open.

2 Saving a part.

Click Save  and file the part under the name Plate. The extension, 
*.sldprt, is added automatically. Click Save.
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What are We 
Going to 
Sketch?

The first feature of a part will be created in this section. That initial 
feature is just the first of many features needed to complete the part.

Sketching Sketching is the act of creating a 2D profile comprised of wireframe 
geometry. Typical geometry types are lines, arcs, circles and ellipses. 
Sketching is dynamic, with feedback from the cursor to make it easier.

Default Planes To create a sketch, you must choose a plane on which to sketch. The 
system provides three initial planes by default. They are Front Plane, 
Top Plane, and Right Plane.

Introducing: Sketch When creating a new sketch, the Sketch tool opens the sketcher on the 
currently selected plane or planar face. You also use the Sketch tool to 
edit an existing sketch.

If you have not preselected a face or plane before activating the Sketch 

tool, the cursor  appears indicating that you should select a face or 
plane.

Where to Find It  CommandManager: Sketch > Sketch 
 Menu: Insert, Sketch
 Shortcut Menu: Right-click a plane or planar face and click 

Sketch
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3 Open a new sketch. 

Click . This will show all three 
default planes for selection in a 
Trimetric orientation. A 
Trimetric orientation is a pictorial 
view that is oriented so the three 
mutually perpendicular planes 
appear unequally foreshortened.

From the screen, choose the Front 
Plane. The plane will highlight and 
rotate.

Note The Reference Triad (lower left corner) shows the orientation of 
the model coordinate axes (red-X, green-Y and blue-Z) at all 
times. It can help show how the view orientation has been 
changed relative to the Front Plane.

4 Sketch active.
The selected Front Plane 
rotates so it is parallel to the 
screen.

The  symbol represents 
the sketch origin. It is 
displayed in the color red, 
indicating that it is active.

Introducing: 
Confirmation Corner

When many SOLIDWORKS commands are active, a symbol or a set of 
symbols appears in the upper right corner of the graphics area. This 
area is called the Confirmation Corner.

Sketch Indicator When a sketch is active, or open, the Confirmation Corner 
displays two symbols. One looks like a sketch. The other is a 
red X. These symbols provide a visual reminder that you are 
active in a sketch. Clicking the sketch symbol exits the sketch and saves 
any changes. Clicking the red X exits the sketch and discards any 
changes.

When other commands are active, the confirmation corner 
displays a check mark and an X. The check mark executes the 
current command. The X cancels the command.

Press the D key to move the confirmation corner to the pointer 
location. 
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Sketch Entities SOLIDWORKS offers a rich variety of sketch tools for creating profile 
geometry. In this lesson, only one of the most basic shapes will be used: 
Lines.

Sketch Geometry The following chart lists some of the sketch entities that are available:

Sketch Entity Button Geometry Example

Line

Circle

Perimeter Circle

Centerpoint Arc

Tangent Arc

3 Point Arc

Ellipse

Partial Ellipse

Parabola

Spline

Straight Slot

Centerpoint 
Straight Slot

3 Point Arc Slot

Centerpoint Arc 
Slot

Polygon
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Basic Sketching The best way to begin sketching is by using the most fundamental 
shape, the Line.

The Mechanics of 
Sketching

To sketch geometry, there are two techniques that can be used:

 Click-Click
Position the cursor where you want the line to start. Click (press 
and release) the left mouse button. Move the cursor to where you 
want the line to end. A preview of the sketch entity will follow the 
cursor like a rubber band. Click the left mouse button a second 
time. Additional clicks create a series of connected lines. 

 Click-Drag
Position the cursor where you want the line to start. Press and hold 
the left mouse button. Drag the cursor to where you want the sketch 
entity to end. A preview of the sketch entity will follow the cursor 
like a rubber band. Release the left mouse button.

Corner Rectangle

Center Rectangle 
(Construction 
geometry can be 
added to any type)

3 Point Corner 
Rectangle

3 Point Center 
Rectangle

Parallelogram

Point

Centerline

Sketch Entity Button Geometry Example
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Introducing: 
Insert Line

The Line tool creates single line segments in a sketch. Horizontal and 
vertical lines can be created while sketching by watching for the 
feedback symbols on the cursor. 

Where to Find It  CommandManager: Sketch > Line 
 Menu: Tools, Sketch Entities, Line
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Entities, Line 

Introducing: Sketch 
Relations

Sketch Relations are used to force a behavior on a sketch element 
thereby capturing design intent. They will be discussed in detail in 
Sketch Relations on page 41.

5 Sketch a line.

Click Line  and sketch a horizontal line from the origin. The  
symbol appears at the cursor, indicating that a Horizontal relation will 
be automatically added to the line. The number indicates the length of 
the line. Click again to end the line. 

Important! Do not be too concerned with making the line the exact length. 
SOLIDWORKS software is dimension driven – the dimensions control 
the size of the geometry, not the other way around. Make the sketch 
approximately the right size and shape and then use dimensions to 
make it exact.

6 Line at angle.
Starting at the end of the first line, 
sketch a line at an angle.

Note The pencil icon at the cursor will be omitted for clarity. 
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Inference Lines 
(Automatic 
Relations)

In addition to the relation symbols, dashed inference lines will also 
appear to help you “line up” with existing geometry. These lines 
include existing line vectors, normals, horizontals, verticals, tangents 
and centers.

Note that some lines capture actual 
geometric relations, while others 
simply act as a guide or reference 
when sketching. A difference in the 
color of the inference lines will 
distinguish them. In the picture at the 
right, the lines labeled “A” are 
yellow, and if the sketch line snaps to 
them, a tangent or perpendicular 
relationship will be captured.

The line labeled “B” is blue. It only provides a reference, in this case 
vertical, to the other endpoint. If the sketch line is ended at this point, 
no vertical relation will be captured.

Note The display of Sketch Relations that appears automatically can be 
toggled on and off using View, Hide/Show, Sketch Relations. It will 
remain on during the initial phase of sketching.

7 Inference lines.
Create a line moving in a direction per-
pendicular to the previous line. This 
causes inference lines to be displayed 
while sketching. A Perpendicular rela-
tion is created between this line and the 
last one.

The cursor symbol indicates that you 
are capturing a perpendicular relation. 

8 Perpendicular.
Create another perpendicular line from 
the last endpoint, again capturing a 
perpendicular relation.

AB
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9 Reference.
Create a horizontal line from the last 
endpoint. Blue inferences are strictly for 
reference and do not create relations. 
They are displayed in blue. This 
reference is used to align the endpoint 
vertically with the origin.

10 Close.
Close the sketch with a final line 
connected to the starting point of the 
first line. 

A closed contour is confirmed with 
shading. 

Note Click Shaded Sketch Contours  from the Sketch 
CommandManager to toggle the shading on and off.

Sketch Feedback The sketcher has many 
feedback features. The 
cursor will change to 
show what type of entity 
is being created. It will 
also indicate what selections on the existing geometry, such as end, 
coincident (on) or midpoint, are available using an orange dot when the 
cursor is on it. 

Three of the most common feedback symbols are:

Symbol Icon Description

Endpoint Yellow concentric circles appear at the Endpoint 
when the cursor is over it.

Midpoint The Midpoint appears as a yellow square. It changes 
to orange when the cursor hovers over the line.

Coincident 
(On Edge)

The quadrant points of the circle appear with a 
concentric circle over the centerpoint.NOT F
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Turning Off Tools Turn off the active tool using one of these techniques:

 Menu Bar: Select 
 CommandManager: Click the active tool to toggle the tool off
 Keyboard Shortcut: Esc

11 Turn off the tool.
Press the Esc key on the keyboard to turn off the line tool. 

Status of a Sketch Sketches can be in one of five definition states at any time. The status 
of a sketch depends on geometric relations between geometry and the 
dimensions that define it. The three most common states are:

Under Defined The sketch is inadequately defined, but the sketch can still be used to 
create features. This is good because many times in the early stages of 
the design process, there isn’t sufficient information to fully define the 
sketch. When more information becomes available, the remaining 
definition can be added at a later time. Under defined sketch geometry 
is blue (by default).

Fully Defined The sketch has all the information necessary to fully describe the 
geometry. Fully defined geometry is black (by default). As a general 
rule, when a part is released to manufacturing, the sketches within it 
should be fully defined.

Over Defined The sketch has duplicate dimensions or conflicting relations and it 
should not be used until repaired. Extraneous dimensions and relations 
should be deleted. Over defined geometry is red (by default).

Note The two other states are No Solution Found and Invalid Solution 
Found. They both indicate that there are errors that must be repaired. 

Rules That 
Govern 
Sketches

Different types of sketches will yield different results. Several different 
types are summarized in the table below. It is important to note that 
some of the techniques shown in the table below are advanced 
techniques that are covered either later in this course, or in other 
advanced courses. 

Sketch Type Description Special Considerations

A typical “standard” 
sketch that is a neatly 
closed contour.

None required.
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12 Current sketch status.
The sketch is Under Defined 
because some of the geometry is 
blue. Note that endpoints of a line 
can be a different color and 
different state than the line itself. 
For example, the vertical line at 
the origin is black because it is (a) 
vertical, and (b) attached to the 
origin. However, the uppermost 

Multiple nested 
contours creates a boss 
with an internal cut.

None required.

Open contour creates a 
thin feature with 
constant thickness.

None required. 

Corners are not neatly 
closed. They should be.

Use the Contour Select Tool. 
Although this sketch will work, it 
represents poor technique and sloppy 
work habits. Do not do it.

Sketch contains a self-
intersecting contour.

Use the Contour Select Tool. If both 
contours are selected, this type of sketch 
will create a Multibody Solid. See Multi-
body Solids in the Advanced Part Model-
ing course.
Although this will work, multibodies are 
an advanced modeling technique that you 
should not use until you have more 
experience.

The sketch contains 
disjoint contours.

This type of sketch can create a Multibody 
Solid. See Multibody Solids in the 
Advanced Part Modeling course.
Although this will work, multibodies are 
an advanced modeling technique that you 
should not use until you have more 
experience.
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endpoint is blue because the length of the line is under defined.

13 Dragging.
Under defined geometry (blue) can be 
dragged to new locations. Fully defined 
geometry cannot. Drag the uppermost 
endpoint to change the shape of the 
sketch. The dragged endpoint appears 
as a blue dot.

14 Undo the change.

Undo the last command by clicking the Undo  option. You can see 
(and select from) a list of the last few commands by clicking the down 
arrow menu. The keyboard shortcut for Undo is Ctrl+Z.

Tip You can also Redo  a change, which reverts it back to the state prior 
to undo. The shortcut for redo is Ctrl+Y.

Design Intent The design intent, as discussed earlier, governs how the part is built and 
how it will change. In this example, the sketch shape must be allowed 
to change in these ways:

What Controls 
Design Intent?

Design intent in a sketch is captured and controlled by a combination of 
two things:

 Sketch relations
Create geometric relationships such as parallel, collinear, 
perpendicular, or coincident between sketch elements.

 Dimensions
Dimensions are used to define the size and location of the sketch 
geometry. Linear, radial, diameter and angular dimensions can be 
added.

To fully define a sketch and capture the desired design intent requires 
understanding and applying a combination of relations and dimensions.

Tip The relations are visible because View, Hide/Show, Sketch Relations 
is toggled on. If it is turned off, clicking the geometry will show the 
relations and open the PropertyManager.

NOT F
OR P

RODUCTIO
N

40



SOLIDWORKS Education 2023 Lesson 2
Introduction to Sketching
The relations will be toggled off at this point, but they will still appear 
on selected geometry. 

Desired Design 
Intent

In order for the sketch to change properly, the correct relations and 
dimensions are required. The required design intent is listed below:

Note The shading has been removed from table images for clarity.

Sketch 
Relations

Sketch Relations are used to force a behavior on a sketch element 
thereby capturing design intent. Some are automatic, others can be 
added as needed. In this example, we will look at the relations on one 
of the lines and examine how they affect the design intent of the sketch.

Automatic Sketch 
Relations

Automatic relations are added as geometry is sketched. We saw this as 
we sketched the outline in the previous steps. Sketch feedback tells you 
when automatic relations are being created.

Horizontal and vertical 
lines

Angle value

Parallel Distance value

Right-angle corners, or 
perpendicular lines

Overall length value
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Added Sketch 
Relations

For those relations that cannot be added automatically, tools exist to 
create relations based on selected geometry.

Introducing: 
Display/Delete 
Relations

Display/Delete Relations shows the relations in a sketch. It also 
enables you to remove relations.

Where to Find It  CommandManager: Sketch > Display/Delete Relations 
 Menu: Tools, Relations, Display/Delete
 Properties PropertyManager: Existing Relations

15 Display the relations associated with a line.
Click the uppermost angled line and the 
PropertyManager opens. The Existing Relations 
box in the PropertyManager lists the geometric 
relations that are associated with the selected line.

16 Remove the relation.
Remove the uppermost relation by clicking the 
relation, either the symbol or in the 
PropertyManager, and pressing the Delete key. 
If the symbol is selected, it changes color and 
displays the entities it controls.

17 Drag the endpoint.
Because the line is no longer constrained to be 
perpendicular, the sketch will behave 
differently when you drag it. Compare this to 
how the sketch behaved when you dragged it in 
step 13.
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Examples of 
Sketch Relations

There are many types of Sketch Relations. Which ones are valid 
depends on the combination of geometry that you select. Selections can 
be the entity itself, endpoints or a combination. Depending on the 
selection, a limited set of options is made available. The following 
chart shows some examples of sketch relations. This is not a complete 
list of all geometric relations. Additional examples will be introduced 
throughout this course. 

Relation Before After

Coincident between 
a line and an 
endpoint.

Merge between two 
endpoints.

Parallel between 
two or more lines.

Perpendicular 
between two lines.

Collinear between 
two or more lines.NOT F
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Horizontal applied 
to one or more lines.

Horizontal between 
two or more 
endpoints.

Vertical applied to 
one or more lines.

Vertical between 
two or more 
endpoints.

Equal between two 
or more lines.

Relation Before After
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Introducing: Add 
Relations

Add Relations is used to create a geometric relationship such as 
parallel or collinear between sketch elements.

Where to Find It  CommandManager: Sketch > Display/Delete Relations  > 

Add Relation 
 Menu: Tools, Relations, Add
 Shortcut Menu: Select one or more sketch objects and click a 

relation

Selecting Multiple 
Objects

As you learned in a previous lesson, you select objects with the left 
mouse button. What about when you need to select more than one 
object at a time? When selecting multiple objects, SOLIDWORKS 
follows standard Microsoft® Windows conventions: hold down the Ctrl 
key while selecting the objects.

Equal between two 
or more arcs or 
circles.

Midpoint between a 
line and an endpoint.

Tangent between a 
line and an arc/circle 
or two arc/circles.

Tangent between a 
line and an arc using 
the common 
endpoint.

Relation Before After
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18 Add a relation.
Hold down Ctrl and click the two lines. The con-
text menu shows only those relations that are 
valid for the geometry selected. 
Click Make Perpendicular. 

19 Drag the sketch.
Drag the sketch back into approximately 
its original shape.

Dimensions Dimensions are another way to define geometry and capture design 
intent in the SOLIDWORKS system. The advantage of using a 
dimension is that it is used to both display the current value and change 
it.

Introducing:
Smart Dimensions

The Smart Dimension tool determines the proper type of dimension 
based on the geometry chosen, previewing the dimension before 
creating it. For example, if you pick an arc the system will create a 
radial dimension. If you pick a circle, you will get a diameter 
dimension, while selecting two parallel lines will create a linear 
dimension between them. In cases where the Smart Dimension tool 
isn’t quite smart enough, you have the option of selecting endpoints 
and moving the dimension to different measurement positions.

Where to Find It  CommandManager: Sketch > Smart Dimension 
 Menu: Tools, Dimensions, Smart
 Shortcut Menu: Right-click in the graphics area and click 

Smart Dimension 
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Dimensioning: 
Selection and 
Preview

As you select sketch geometry with the dimension tool, the system 
creates a preview of the dimension. The preview enables you to see all 
the possible options by simply moving the mouse after making the 
selections. Clicking the left mouse button places the dimension in its 

current position and orientation. Clicking the right mouse button  
locks only the orientation, allowing you to move the text before final 
placement by clicking the left mouse button.

With the dimension tool and two endpoints selected, below are three 
possible orientations for a linear dimension. The value is derived from 
the initial point to point distance and may change based on the 
orientation selected.

Note Another option is to select the geometry that is to be dimensioned and 

click Auto Insert Dimension .

20 Adding a linear dimension.

Click Smart Dimension  and 
click the line shown and right-click 

 to lock in the orientation. Click 
again to place the text as shown. The 
dimension appears with a Modify 
tool displaying the current length of 
the line. The thumbwheel is used to 
incrementally increase/decrease the 
value using the middle mouse 
button. Or with the text highlighted, you can type a new value to 
change it directly.

Endpoints
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Note A midpoint location can be inadvertently selected 
instead of the geometry itself. To avoid this, select the 
geometry slightly off center.

The Modify Tool The modify tool that appears when you create or 
edit a dimension (parameter) has several 
options. The options available to you are:

 Dial the value up or down.

 Save the current value and exit the dialog box.

 Restore the original value and exit the dialog box.

 Rebuild the model with the current value.

 Reverse the sense of the dimension.

 Change the thumbwheel increment value.

 Mark the dimension for drawing import.

Note The dimension name can be changed in the upper section of the dialog 
box.

Units in the Modify 
Tool

Units different from the part units can be 
selected for the input. When typing the 
value, select the Units > menu and select 
input units.

Note Unit abbreviations and fractions can also be typed into the value field 
after the numeric value (for instance 0.375in or 3/8”).NOT F

OR P
RODUCTIO

N

48



SOLIDWORKS Education 2023 Lesson 2
Introduction to Sketching
21 Set the value. 
Change the value to 20 and click the 

Save  option. The dimension 
forces the length of the line to be 
20mm.

Tip Pressing Enter has the same effect as clicking the Save  button.

22 Linear dimensions.
Add additional linear dimensions 
to the sketch as shown.

Dimensioning Tip When you dimension a sketch, 
start with the smallest dimension 
first, and work your way to the 
largest. 
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Angular 
Dimensions

Angular dimensions can be created using the same dimension tool used 
to create linear, diameter and radial dimensions. Select either two lines 
that are both non-collinear and non-parallel, or select three non-
collinear endpoints.

Depending on where you place the angular dimension, you can get the 
interior or exterior angle, the acute angle, or the oblique angle. Possible 
placement options:

23 Angular dimension.
Using the dimension tool, create 
the angular dimension shown and 
set the value to 125°.

The sketch is fully defined. See 
Fully Defined on page 38.
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Instant 2D Instant 2D can be used to manipulate sketch dimensions, dynamically 
changing the values using a graphic Ruler. 

Note The ruler is displayed to guide the drag. Moving closer to the ruler 
gradients allows you to snap to them. 

Where to Find It  CommandManager: Sketch > Instant 2D 

24 Select dimension.
The Instant 2D tool is on by default. Select the 125° dimension.

Click and hold the round ball handle at the tip of the arrow. 

The value of the dimension, and the geometry, changes dynamically as 
the handle is dragged.

Drag the value to 135° using the ruler. 

Extrude Once the sketch is completed, it can be extruded to create the first 
feature. There are many options for extruding a sketch including the 
start and end conditions, draft and depth of extrusion, which will be 
discussed in more detail in later lessons. Typically, extrusions take 
place in a direction normal to the sketch plane, in this case the Front 
plane.

Where to Find It  CommandManager: Features > Extruded Boss/Base 
 Menu: Insert, Boss/Base, ExtrudeNOT F
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25 Extrude. 

Click Extruded Boss/Base .

On the Features 
CommandManager tab, the 
options for other methods of 
creating features are listed along 
with Extrude and Revolve. They 
are unavailable because this 
sketch does not meet the 
conditions necessary for creating 
these types of features. 

The view automatically changes 
to Trimetric and a preview of the feature is shown at the default depth. 

Drag Handles and 
Rulers

Handles  appear that can be 
used to drag the preview to the 
desired depth. The handle is 
colored while dragging in the 
active direction. A callout shows 
the current depth value and a 
ruler.

26 Extrude Feature settings.
Change the settings as shown.

 End Condition = Blind

  (Depth) = 6mm 

Click OK  to create the feature.
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Tip The OK button  is just one way to accept and complete the process. 
A second is to press the Enter key. 

A third method is the set of OK/Cancel buttons in the 
Confirmation Corner of the graphics area, or press the D key 
to bring it to the cursor.

A fourth method is to right-click and click OK 
from the shortcut menu.

27 Completed feature.
The completed feature is the first solid, 
or feature of the part. The sketch is 
absorbed into the Extrude1 feature.

Note Click the  preceding the feature name to expand 
the feature and show the sketch. 

28 Save and close.

Click Save  then click File, Close to close the part.
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Sketching 

Guidelines†
Following is a collection of “rules of thumb” or best practices for 
sketching of which all SOLIDWORKS users should be aware. Some of 
these tips are covered in substantial detail in subsequent lessons within 
this book.

 Keep your sketches simple. Simple sketches are easier to edit, less 
likely to develop errors, and help with downstream features such as 
configurations. 

 Make use of the origin in your first sketch.

 The first sketch of a new part should represent the main profile of 
the part. 

 Create sketch geometry first, add geometric relationships second, 
and then add your dimensions last. Dimensions can sometimes 
interfere with the addition of required relations.

 Use geometric relations wherever possible to maintain design 
intent.

 Draw the sketch to approximately the right scale to prevent errors 
or geometry overlap when you start adding dimensions.

 Add or edit dimensions on the closest / smallest geometry first, then 
work your way to the outer / larger geometry to prevent geometry 
overlap.

 Use relations, equations, and global variables to reduce the number 
of independent dimensions needed. 

 Take advantage of symmetry. Use the Mirror or Dynamic Mirror 
sketch tool to mirror sketch elements and add symmetrical 
relations. 

 Be flexible. It may be necessary to change the order in which 
you’re adding dimensions or relations. Drag the sketch geometry 
closer to the required location before adding dimensions.

 Fix errors as they occur. Use SketchXpert and Check Sketch for 
Feature which can quickly help you identify problems and correct 
them.

† Thanks to Joe Medeiros, Javelin Technologies.
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Exercise 1:
Sketch and 
Extrude 1 

Create this part using the information and 
dimensions provided. Sketch and extrude 
profiles to create this part. 

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic 

Relations) on page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters 

1 New part. 
Create a new part using the Part_MM template.

2 Sketch. 
Create this sketch on the Front Plane using lines, automatic relations 
and dimensions. 

3 Extrude. 
Extrude the sketch 50mm in 
depth. 

4 Save and close the part. NOT F
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Exercise 2:
Sketch and 
Extrude 2 

Create this part using the information and 
dimensions provided. Sketch and extrude 
profiles to create this part. 

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic 

Relations) on page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters 

1 New part. 
Create a new part using the Part_MM template.

2 Sketch. 
Create this sketch on the Front Plane using lines, automatic relations 
and dimensions. 

3 Extrude. 
Extrude the sketch 50mm in 
depth. 

4 Save and close the part. NOT F
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Exercise 3:
Sketch and 
Extrude 3

Create this part using the information 
and dimensions provided. Sketch and 
extrude profiles to create this part. 

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic 

Relations) on page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters 

1 New part. 
Create a new part using the Part_MM template.

2 Sketch. 
Create this sketch on the Front Plane using lines, automatic relations 
and dimensions. 

3 Extrude. 
Extrude the sketch 25mm in depth. 

4 Save and close the part. NOT F
OR P
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Exercise 4:
Sketch and 
Extrude 4

Create this part using the information 
and dimensions provided. Sketch and 
extrude profiles to create this part. 

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic 

Relations) on page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters 

1 New part. 
Create a new part using the Part_MM template.

2 Sketch. 
Create this sketch on the 
Front Plane using lines, 
automatic relations and 
dimensions. 

3 Extrude. 
Extrude the sketch 100mm in depth. 

4 Save and close the part. NOT F
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Exercise 5:
Sketch and 
Extrude 5

Create this part using the information and 
dimensions provided. Sketch and extrude 
profiles to create the part.

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic Relations) on 

page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters

1 New part.
Create a new part using the Part_MM template.

2 Sketch.
Create this sketch on the Front Plane using lines, automatic relations 
and dimensions.

Fully define the sketch.

3 Extrude.
Extrude the sketch 25mm in 
depth.

4 Save and close the part.NOT F
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Exercise 6:
Sketch and 
Extrude 6

Create this part using the information and 
dimensions provided. Sketch and extrude 
profiles to create the part.

This lab reinforces the following skills:

 Introducing: New Part on page 29
 Sketching on page 31
 Inference Lines (Automatic Relations) 

on page 36
 Dimensions on page 46
 Extrude on page 51

Units: millimeters

1 New part.
Create a new part using the Part_MM template.

2 Automatic relations.
Create this sketch on the Front Plane using lines and automatic 
relations. Show the Perpendicular and Vertical relations.

3 Dimensions.
Add dimensions to fully define the 
sketch.

4 Extrude.
Extrude the sketch 12mm.

5 Save and close the part.
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Lesson 3
Basic Part Modeling

Upon successful completion of this lesson, you will be able to:

 Choose the best profile for sketching.

 Choose the proper sketch plane.

 Extrude a sketch as a cut.

 Create Hole Wizard holes.

 Insert fillets on a solid.

 Use the editing tools Edit Sketch, Edit Feature and Rollback. 

 Make a basic drawing of a part.

 Make a change to a dimension.

 Demonstrate the associativity between the model and its drawings.
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Basic Modeling This lesson discusses the 
considerations that you 
make before creating a 
part, and shows the 
process of creating a 
simple one.

Stages in the 
Process

The steps in planning and executing the creation of this part are listed 
below.

 Terminology
What are the terms commonly used when talking about modeling and 
using the SOLIDWORKS software?

 Profile choice
Which profile is the best one to choose when starting the modeling 
process?

 Sketch plane choice
Once you’ve chosen the best profile, how does this affect your choice 
of sketch plane?

 Design intent
What is design intent and how does it affect the modeling process?

 New part
Opening the new part is the first step.

 First feature
What is the first feature?

 Bosses, cuts and hole features
How do you modify the first feature by adding bosses, cuts and holes?

 Fillets
Rounding off the sharp corners – filleting.

 Editing tools
Use three of the most common editing tools. 

 Drawings
Creating a drawing sheet and drawing views of the model.

 Dimension changes
Making a change to a dimension changes the model’s geometry. How 
does this happen?
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Terminology Moving to 3D requires some new terminology. The SOLIDWORKS 
software employs many terms that you will become familiar with 
through using the product. Many are terms that you will recognize from 
design and manufacturing such as cuts and bosses.

Feature All cuts, bosses, planes and sketches that you create are considered 
Features. Sketched features are those based on sketches (boss and cut), 
and applied features are applied directly to existing geometry (fillet).

Plane Planes are flat and infinite. They are represented on the screen with 
visible edges. They are used as the primary sketch surface for creating 
boss and cut features.

Extrusion Although there are many ways to 
create features and shape the solid, 
for this lesson, only extrusions 
will be discussed. An extrusion 
will extend a profile along a path 
typically normal to the profile 
plane for some distance. The 
movement along that path becomes the solid model. 

Sketch In the SOLIDWORKS system, the name used to 
describe a 2D profile is sketch. Sketches are created 
on flat faces and planes within the model. They are 
generally used as the basis for bosses and cuts, 
although they can exist independently.

Boss Bosses are used to add material to the model. The critical initial feature 
is always a boss. After the first feature, you may add as many bosses as 
needed to complete the design. As with the base, all bosses begin with a 
sketch.

Cut A Cut is used to remove material from the model. This is the opposite 
of the boss. Like the boss, cuts begin as 2D sketches and remove 
material by extrusion, revolution, or other methods you will learn 
about.

Fillets and Rounds Fillets and rounds are generally added to the solid, not the sketch. By 
nature of the faces adjacent to the selected edge, the system knows 
whether to create a round (removing material) or a fillet (adding 
material).

Design Intent How the model should be created and changed, is considered the design 
intent. Relationships between features and the sequence of their 
creation all contribute to design intent.
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Choosing the 
Best Profile

Choose the “best” profile for the model's base feature. This profile, 
when extruded, will generate more of the model than any other. Look at 
these models as examples. 

Part Best Profile Extruded
NOT F

OR P
RODUCTIO

N

64



SOLIDWORKS Education 2023 Lesson 3
Basic Part Modeling
Choosing the 
Sketch Plane

Once the best profile is determined, the next step is to decide which 
view to use and select the plane with the same name for sketching it. 
The SOLIDWORKS software provides three planes; they are described 
below.

Planes There are three default planes, labeled Front Plane, Top Plane and 
Right Plane. Each plane is infinite, but has screen borders for viewing 
and selection. Also, each plane passes through the origin and is 
mutually perpendicular to the others.

The planes can be renamed. In this course the names Front Plane, Top 
Plane and Right Plane are used. This naming convention is used in 
other CAD systems and is comfortable to many users.

Although the planes 
are infinite, it may be 
easier to think of them 
as forming an open 
box, connecting at the 
origin. Using this 
analogy, the inner 
faces of the box are the 
potential sketch 
planes.

Placement of the 
Model

The part will be placed into the box three times. Each time the best 
profile will contact or be parallel to one of the three planes. Although 
there are many combinations, the choices are limited to three for this 
exercise.

When choosing the sketch plane, consider the part's appearance and its 
orientation in an assembly. The appearance dictates how the part will 
be oriented in standard views such as the Isometric. It also determines 
how you will spend most of your time looking at the model as you 
create it.

The part's orientation in an assembly dictates how it is to be positioned 
with respect to other, mating parts.

Orient the Model for 
the Drawing

Another consideration when deciding which sketch plane to use is how 
you want the model to appear on the drawing when you detail it. You 
should build the model so that the front of the model is the same as the 
Front view in the drawing. This saves time during the detailing process 
because you can use predefined views.NOT F
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In the first example, the best 
profile is in contact with the Top 
plane.

In the second example, it is 
contacting the Front plane.

The last example shows the best 
profile in contact with the Right 
plane.

Chosen Plane The Top plane orientation seems 
to be the best. This indicates that 
the best profile should be 
sketched on the Top plane of the 
model.

How it Looks on the 
Drawing

By giving careful thought to 
which plane is used to 
sketch the profile, the 
proper views are easily 
generated on the detail 
drawing.

Right Plane Front Plane

Top Plane

Right Plane Front Plane

Top Plane

Right Plane Front Plane

Top Plane
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Details of the 
Part

The part we will be creating is shown below. There are two main boss 
features, some cuts, and fillets.

Standard Views The part is shown here in four standard views.

Main Bosses The two main bosses have distinct 
profiles in different planes. They 
are connected as shown in the 
exploded view at right.

Best Profile The first feature of the model 
is created from the 
rectangular sketch shown 
overlaid on the model. This is 
the best profile to begin the 
model. 

The rectangle will then be 
extruded as a boss to create 
the solid feature.
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Sketch Plane Placing the model “in the box” determines which plane should be used 
to sketch on. In this case it will be the Top plane. 

Design Intent The design intent of this part describes how the part’s relationships 
should or should not be created. As changes to the model are made, the 
model will behave as intended.

 All holes are through holes.

 The slot is aligned with the 
tab.

 The counterbored hole in the 
front shares the same center 
point as the rounded face of 
the tab. 

Procedure The modeling process includes sketching and creating bosses, cuts and 
fillets. To begin with, a new part file is created.

1 New part.

Click New , or click File, New. Create a new part using the 
Part_MM template and Save it as Basic.

2 Select the sketch plane.
Insert a new sketch and choose 
the Top Plane.

Tip A plane doesn’t have to be shown 
in order to be used; it can be 
selected from the 
FeatureManager design tree.

Sketch Plane
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Sketching the First 
Feature

Create the first feature by extruding a sketch into a boss. The first 
feature is always a boss, and it is the first solid feature created in any 
part. Begin with the sketch geometry, a rectangle.

Introducing: 
Corner Rectangle

Corner Rectangle is used to create a rectangle in a sketch. The 
rectangle is comprised of four lines (two horizontal and two vertical) 
connected at the corners. It is sketched by indicating the locations of 
two diagonal corners. There are several other rectangle/parallelogram 
tools available:

 Center Rectangle  - Uses a center point and corner to create a 
rectangle with horizontal and vertical lines. 

 3 Point Center Rectangle  - Creates a rectangle based on a 
center point, midpoint of edge and corner. Lines are perpendicular 
at corners. 

 3 Point Corner Rectangle  - Uses three corners to define a 
rectangle. Lines are perpendicular at corners. 

 Parallelogram  - Uses three corners to define a parallelogram 
(corners are not perpendicular). 

Where to Find It  CommandManager: Sketch > Corner Rectangle 
 Menu: Tools, Sketch Entities, Corner Rectangle
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Entities, Corner Rectangle 

3 Sketch a rectangle.
Click Corner Rectangle  
and begin the rectangle at the 
origin.

Make sure the rectangle is locked to the origin by looking for 
the coincident icon next to the cursor as you begin sketching. 
Do not worry about the size of the rectangle. Dimensioning it 
will take care of that in the next step.

4 Fully defined sketch. 
Add dimensions to the sketch. The 
sketch is fully defined.
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Extrude Options An explanation of some of the more frequently used Extrude options is 
given below (see Extrude on page 51). Other options will be discussed 
in later lessons.

 End Condition Type
A sketch can be extruded in one or two directions. Either or both 
directions can terminate at some blind depth, up to some geometry in 
the model, or extend through the whole model.

 Depth
The distance for a blind or mid-plane extrusion. For mid-plane, it refers 
to the total depth of the extrusion. That would mean that a depth of 
50mm for a mid-plane extrusion would result in 25mm on each side of 
the sketch plane.

 Draft
Applies draft to the extrusion. Draft on the extrusion can be inwards 
(the profile gets smaller as it extrudes) or outward.

5 Extrude.

Click Extrude  and extrude the rectangle 10mm upwards. Click OK.

Renaming 
Features

Any feature that appears in the FeatureManager design tree (aside from 
the part itself) can be renamed using the procedure below. Renaming 
features is a useful technique for finding and editing features in later 
stages of the model. Well chosen, logical names help you to organize 
your work and make it easier when someone else has to edit or modify 
your model.

6 Rename the feature.
It is good practice to rename important features that you create with 
some meaningful name. In the FeatureManager design tree, use a very 
slow double-click to edit the feature Boss-Extrude1. When the name 
is highlighted and editable, type BasePlate as the new feature name. 
All features in the SOLIDWORKS system can be edited in the same 
way.

Tip Instead of using a slow double-click to edit the name, you can select the 
name and press F2.
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Boss Feature The next feature will be the boss 
with a curved top. The sketch 
plane for this feature will be a 
planar face of the model instead 
of an existing plane. The required 
sketch geometry is shown 
overlaid on the finished model. 

Sketching on a 
Planar Face

Any planar (flat) face of the model can be used as a sketch plane. 

Simply select the face and click Sketch . Where faces are difficult 
to select because they are obscured by other faces, the Select Other 
tool can be used to choose a face without reorienting the view. In this 
case, the planar face on the front of the BasePlate is used.

7 Insert new sketch.
Select the indicated face and click 

Sketch . 

Note Make sure that Features > Instant 3D  is turned off. Leaving it on 
will cause several handles and axes that we are not currently using to 
appear on the face. 

Sketching SOLIDWORKS offers a rich variety of sketch tools for creating profile 
geometry. In this example, Tangent Arc is used to create an arc that 
begins tangent to a selected endpoint on the sketch. Its other endpoint 
can be placed in space or on another sketch entity.

Introducing: 
Tangent Arc

Tangent Arc is used to create tangent arcs in a sketch. The arc must be 
tangent to some other entity, line or arc, at its start.

Where to Find It  CommandManager: Sketch > Arc  > Tangent Arc 
 Menu: Tools, Sketch Entities, Tangent Arc
 Shortcut Menu: Right-click in the graphics area and click 

Sketch Entities, Tangent Arc 

Sketch Plane
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Tangent Arc Intent 
Zones

When you sketch a tangent arc, the 
SOLIDWORKS software infers from the motion 
of the cursor whether you want a tangent or 
normal arc. There are four intent zones, with 
eight possible results as shown.

You can start sketching a tangent arc from the end point of any existing 
sketch entity (line, arc, spline, and so on). Move the cursor away from 
the end point.

 Moving the cursor in a tangent direction creates one of the four 
tangent arc possibilities.

 Moving the cursor in a normal direction creates on of the four 
normal arc possibilities.

 A preview shows what type of arc you are sketching.

 You can change from one type of tangent arc to the other by 
returning the cursor to the endpoint and moving away in a different 
direction.

Autotransitioning 
Between Lines and 
Arcs

When using Line , you can switch from sketching a line to sketching 

a tangent arc, and back again, without clicking Tangent Arc . You 
can do this by returning the cursor to the endpoint and moving away in 
a different direction or by pressing the A key on the keyboard.

8 Vertical line.

Click Line  and start the vertical 
line at the lower edge capturing a 

Coincident  relation at the lower 

edge and Vertical relation .

9 Autotransition.
Move the cursor back to the endpoint and move away in a different 
direction.You are now in tangent arc mode.

10 Tangent arc.
Sketch a 180° arc tangent to the 
vertical line. Look for the inference 
line indicating that the end point of 
the arc is aligned horizontally with 
the arc’s center.

When you finish sketching, the 
sketch tool automatically switches 
back to the line tool.
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11 Finishing lines.
Create a vertical line from the arc end 
to the base, and one more line 
connecting the bottom ends of the 
two vertical lines.

Note that the horizontal line is black, 
but its endpoints are not.

12 Add dimensions.
Add linear and radial 
dimensions to the sketch.

As you add the dimensions, 
move the cursor around to view 
different possible orientations.

Always dimension to an arc by selecting on its circumference, rather 
than center. This makes other dimensioning options (min and max) 
available.

13 Extrude direction.

Click Extrude  and set the 
Depth to 10mm. Note that the 
preview shows the extrusion 
going into the base, in the 
proper direction.

If the direction of the preview is 
away from the base, click 
Reverse Direction .

Note When using the Spin Increment arrows, the 
default up and down increment is 10mm. 
Pressing the Alt key with an arrow drops it to
1/10X, or 1mm. Using it with Ctrl key it 
increases it 10X to 100mm.NOT F
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14 Completed boss.
The boss merges with the previous 
base to form a single solid.

Rename the feature VertBoss. 

Cut Feature Once the two main boss features are completed, it is time to create a cut 
to represent the removal of material. Cut features are created in the 
same way as bosses - in this case with a sketch and extrusion.

Introducing: 
Cut Extrude

The menu for creating a cut feature by extruding is identical to that of 
creating a boss. The only difference is that a cut removes material while 
a boss adds it. Other than that distinction, the commands are the same. 
This cut represents a slot.

Where to Find It  CommandManager: Features > Extruded Cut 
 Menu: Insert, Cut, Extrude

15 Rectangle.
Press Space bar and click 

Front . Start a sketch on 
this large face and add a 
rectangle Coincident with 
the bottom model edge.

Turn off the rectangle tool.

16 Dimensions. 
Add a dimension as shown. 

Note The sketch is under defined, but it will be made fully defined later in 
this lesson. See Status of a Sketch on page 38.NOT F
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View Selector The View Selector helps to visualize how 
views of the model will appear by using a 
transparent cube surrounding the model. 

Select a face of the cube to look at the model 
through the cube, normal to that face or select 
a view orientation by name. 

The cube can also be rotated prior to selecting 
a face.

Where to Find It  Heads-up View Toolbar: View Orientation  and 

View Selector
 Keyboard Shortcut: Space bar

Note Pressing the Space Bar opens the View Selector and the Orientation 
dialog box. Pressing Ctrl+Space bar opens only the View Selector.

17 View Selector.
Press Space Bar and click the corner of the cube that is labeled 
Isometric.
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18 Through All Cut.

Click Extruded Cut . Choose Through All 
and click OK. This type of end condition always 
cuts through the entire model no matter how far. 
No depth setting was needed. Rename the 
feature BottomSlot.

Using the Hole 
Wizard

The Hole Wizard is used to create specialized holes in a solid. It can 
create simple, tapered, counterbored and countersunk holes using a step 
by step procedure. I n this example, the Hole Wizard will be used to 
create a standard hole.

Creating a 
Standard Hole

You can choose the face to insert the hole onto, define the hole’s 
dimensions and locate the hole using the Hole Wizard. One of the most 
intuitive aspects of the Hole Wizard is that you specify the size of the 
hole by the fastener that goes into it.

Tip You can also place holes on planes and non-planar faces. For example, 
you can create a hole on a cylindrical face.

Counterbore Hole A counterbore hole is required in this model. Using the front face of the 
model and a relation, the hole can be positioned.

Note The Advanced Hole Wizard (Insert, Features, 
Advanced Hole) is similar to the Hole Wizard, but 
allows you to design a stack of hole styles including 
counterbores, countersinks, tapered, tapped, and 
standard holes. 

Introducing: 
The Hole Wizard

The Hole Wizard creates shaped holes, such as countersunk and 
counterbore types. The process creates two sketches. One defines the 
shape of the hole. The other, a point, locates the center.

Where to Find It  CommandManager: Features > Hole Wizard 
 Menu: Insert, Features, Hole WizardNOT F
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19 Select Counterbore.
Select the face indicated and click Hole 

Wizard . Set the properties of the hole as 
follows:

Type: Counterbore

Standard: ANSI Metric

Type: Hex Bolt - ANSI B18.2.3.5M

Size: M8

End Condition: Through All

20 Wake up the centerpoint.
Click the Positions tab.

Hover the cursor over the 
circumference of the large arc. 
Do not click.

When the Coincident symbol 
appears , the center point of 
the large arc has been “woken 
up” and is now a point you can 
snap to. 

Click the point onto the arc’s centerpoint. Look for the feedback that 
tells you that you are snapping to the arc’s center, a coincident relation. 
Click OK to complete the dialog.

Select this face
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Filleting Filleting refers to both fillets (adding volume) and rounds (removing 
volume). The distinction is made by the geometric conditions, not the 
command itself. Fillets are created on selected edges of the model. 
Those edges can be selected in several ways, and several options exist 
for creating different fillet types including constant size, variable size, 
face and full round fillets. Fillet profile options include circular, conic 
and curvature continuous. 

Note See the Advanced Part Modeling course for more information on fillet 
types and options.

Filleting Rules Some general filleting rules are:

1. Leave cosmetic fillets until the end.
2. Create multiple fillets that will have the same radius in the same 

command.
3. When you need fillets of different radii, generally you should make 

the larger fillets first.
4. Fillet order is important. Fillets create faces and edges that can be 

used to generate more fillets.
5. Existing fillets can be converted to chamfers (see Chamfers on 

page 175). 

Selection Toolbar The Selection Toolbar can be used to turn a single edge selection into 
multiple, related, selections. It will not be used in this example, but it 
will be explained in Edge Selection on page 173.

Preview You have a choice between Full preview, Partial preview and No 
preview of the fillet. Full preview, as shown in the following images, 
generates a mesh preview on each selected edge. Partial preview only 
generates the preview on the first edge you select. As you gain 
experience with filleting, you will probably want to use Partial or No 
preview because they are faster.NOT F
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Where to Find It  CommandManager: Features > Fillet 
 Menu: Insert, Features, Fillet/Round

 Shortcut Menu: Right-click a face or edge and click Fillet 

21 Insert Fillet.

Click Fillet . Click Manual, click Constant 

Size Fillet  and set the radius value to 
8mm. 

Clear Show selection toolbar and click Full 
preview.

22 Select edge.
Select the two hidden edges shown through the 
model as shown.

23 Additional selections.
Select the additional four corner edges as shown and click OK. 

Note All six fillets are controlled by the same dimension value. The creation 
of these fillets has generated new edges suitable for the next series of 
fillets.NOT F
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Recent Commands SOLIDWORKS provides a 
“just used” buffer that lists 
the last few commands for 
easy reuse. The Enter key can 
also be used to re-launch the 
last used command.

Recent Features The History folder contains a list of the most 
recent features that have been created or 
edited. This is useful for getting access to 
recent features. See Editing Tools on page 81 
for more information.

24 Recent Command.
Right-click in the graphics area and click Recent Commands and the 
Fillet command from the drop-down list to use it again.

25 Preview and propagate.
Add another fillet, radius 3mm, using Full 
preview.

Select the edges indicated to see the 
selected edges and preview. 

Click OK.NOT F
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Editing Tools Three of the most common editing tools are introduced in this lesson: 
Edit Sketch, Edit Feature and Rollback. They can be used to edit and 
repair sketches and features as well as specify where, in the 
FeatureManager design tree, the features are to be created. 

Tip The other editing tools are found later in this lesson: Editing Features 
on page 82 and Rollback Bar on page 82. 

Editing a Sketch Once created, sketches can be changed using Edit Sketch. This opens 
the selected sketch so that you can change anything: the dimension 
values, the dimensions themselves, the geometry or geometric 
relations. 

Introducing: 
Edit Sketch

Edit Sketch enables you to access a sketch and make changes to any 
aspect of it. During editing, the model is “rolled back” to its state at the 
time the sketch was created. The model will be rebuilt when the sketch 
is exited. 

Where to Find It  Shortcut Menu: Right-click a sketch or feature and click 

Edit Sketch
 Menu: Select a face and click Edit, Sketch

26 Edit the sketch. 

Right-click the BottomSlot feature and click Edit Sketch . The 
existing sketch will be opened for editing. 

Selecting Multiple 
Objects

As you learned in Selecting Multiple Objects on page 45, when 
selecting multiple objects, hold down the Ctrl key and then select the 
objects.

27 Relations. 
Select the endpoint and edge as shown and add 
a Coincident relation.

28 Repeat.
Repeat the procedure for the endpoint 
at the other end of the rectangle as 
shown. The addition of these relations 
will fully define the sketch.NOT F
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Note For more information about relations, see Sketch Relations on page 41. 

29 Exit the sketch. 

Click Exit Sketch  in the upper right (confirmation) corner to 

exit the sketch and rebuild the part. 

Editing Features The second fillet should also be applied to the top edges of the Base 
Plate. To do this we will edit the definition of the last fillet feature.

Introducing: 
Edit Feature

Edit Feature changes how a feature is applied to the model. Each 
feature has specific information that can be changed or added to, 
depending on the type of feature it is. As a general rule, the same dialog 
box used to create a feature is used to edit it.

Fillet Propagation The Tangent Propagation checkbox within the Fillet tool allows a 
fillet feature to flow to tangent edges of the selections made.

Where to Find It  Menu: Select a feature and click Edit, Definition

 Shortcut Menu: Right-click a feature and click Edit Feature 

30 Edit the feature. 

Right-click the Fillet2 feature and click Edit Feature . The existing 
feature will be opened for editing using the same PropertyManager that 
was used to create the feature. Make sure that Tangent Propagation is 
clicked.

31 Select additional edge. 
Select the additional short edge as shown and 
the propagation will create the fillets as 
shown. Click OK. 

Rollback Bar The Rollback Bar is the blue horizontal bar 
located at the bottom of the FeatureManager 
design tree. 

The Rollback Bar has many uses. It can be used to “walk through” a 
model showing the steps that were followed to build it or to add 
features at a specific point in the part’s history. In this example, it will 
be used to add a hole feature between the existing fillet features. 

NOT F
OR P

RODUCTIO
N

82



SOLIDWORKS Education 2023 Lesson 3
Basic Part Modeling
Using Rollback with 
Large Parts

The Rollback Bar is also useful when editing large parts to limit 
rebuilding. Roll back to the position just after the feature that you are 
editing. When the editing is completed, the part is rebuilt only up to the 
rollback bar. This prevents the entire part from being rebuilt. The part 
can be saved in a rollback state.

Introducing: The 
Rollback Bar

You can roll back a part using the Rollback Bar in the FeatureManager 
design tree. The rollback bar is a line which highlights when selected. 
Drag the bar up or down the FeatureManager design tree to step 
forward or backward through the regeneration sequence.

Note To move the rollback bar with the arrow keys, click Tools, Options, 
System Options, FeatureManager, Arrow key navigation. The 
focus must be set to the rollback bar by clicking on it. If the focus is set 
to the graphics area, the arrow keys will rotate the model.

Where to Find It  Shortcut Menu: Right-click a feature and click Rollback 
 Shortcut Menu: Right-click in the FeatureManager design tree and 

click Roll to Previous or Roll to End

32 Rollback. 
Click on the Rollback Bar and drag it upwards. Drop it before the fillet 
features as shown.
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33 Hole Wizard.

Click the Hole Wizard  and click the Positions tab.

34 Face selection.
Select the face indicated.

35 Holes.
Add two points and dimension them as shown.

36 Type.
Click the Type tab and set the properties of the 
hole as follows. Click OK.

Type: Hole

Standard: Ansi Metric

Type: Drill sizes

Size: 7.0

End Condition: Through All

Select this face
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37 Change the view orientation.

Click Isometric  to change view 
orientation. 

38 Roll to end. 
Right-click on the rollback bar and click Roll 
to End. 

Introducing: 
Appearances

Use Appearances to change the color and optical properties of 
graphics. Color Swatches can also be created for user defined colors. 

Where to Find It  Shortcut Menu: Right-click a face, feature, body, part, or 
component, click Appearances, and click the item to edit

 Heads-up View Toolbar: Edit Appearance 
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39 Select swatch.

Click Edit Appearance . Under the Color 
selection, select the standard swatch and one 
of the colors as shown.

Click OK.

40 Display appearances. 

Click the DisplayManager  tab to see the 
color listed. Click the FeatureManager design 

tree  tab. 

Tip The DisplayManager can also be used to view and modify decals, 
scenes, lights and cameras. 

A Note About Color 
in the User Interface

You can customize the colors of the SOLIDWORKS user interface. 
This is done through Tools, Options, System Options, Colors. You 
can select predefined color schemes, or create your own. In some cases, 
we have altered colors from their default settings to improve clarity and 
reproduction quality. As a result, the colors on your system may not 
match the colors used in this book.

41 Save the results. 

Click Save  to save your work.
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Detailing Basics SOLIDWORKS enables you to easily create drawings from parts or 
assemblies. These drawings are fully associative with the parts and 
assemblies they reference. If you change the model, the drawing will 
update.

Various topics related to making drawings are integrated into several 
lessons throughout this book. The material presented here is just the 
beginning. Specifically:

 Creating a new drawing file and sheet. 
 Creating drawing views using the View Palette.
 Using dimension assist tools. 

A comprehensive treatment of detailing is offered in the course 
SOLIDWORKS Drawings. 
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Settings Used in 
the Template

The drawing template used in this section has been designed to include 
the Document Properties shown in the chart below. Settings are 
accessed through Tools, Options. The settings that will be used in this 
lesson are:

CommandManager 
Tabs

When working in a drawing document, the CommandManager tabs 
will update to include toolbars that are specific to the process of 
detailing and making drawings. They are:

 Drawing

 Annotation

New Drawing Drawing files (*.SLDDRW) are SOLIDWORKS files that contain 
drawing sheets. Each sheet is the equivalent of a single sheet of paper.

Introducing: Make 
Drawing from Part

Make Drawing from Part takes the current part and steps through the 
creation of a drawing file, sheet format and initial drawing views using 
that part.

Where to Find It  Menu Bar: New , Make Drawing from Part/Assembly 
 Menu: File, Make Drawing from Part 

System Options
Document Properties
(Set using drawing template)

Drawings, Display Style:
• Display style for new views = 

Hidden lines removed

• Tangent Edges = Visible

Drafting Standard:
• Overall drafting standard = 

ANSI 

Colors:
• Drawings, Hidden Model Edges 

= Black

Dimensions:
• Font = Century Gothic

• Primary precision = .123

• Add parentheses by default = 
Selected

Detailing, Auto insert on view 
creation:
• All options = cleared

Units
• Unit system =MMGS
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1 Create Drawing.

Click Make Drawing from Part/Assembly  and choose 
B_Size_ANSI_MM from the Training Templates tab.

The sheet format creates a B-size drawing (11” x 17”) arranged with its 
long edge horizontal. The sheet format includes a border, title block, 
and other graphics.

Tip Double-clicking the template will automatically open it, eliminating the 
need to click OK.

Drawing Views The initial task of detailing is the creation of views. Using the Make 
Drawing from Part/Assembly tool leads you through the selection of 
the drawing sheet to the View Palette. Previews of the model 
orientations are shown in the lower pane of the View Palette. Create 
views on the drawing sheet by using a drag and drop procedure. 
Additional views can be projected or folded directly from the dropped 
view. 

These options are discussed in detail in the SOLIDWORKS Drawings 
course.

2 View Palette.
Clear Import Annotations. Drag the Front view from the View 
Palette and drop it onto the drawing as shown.
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3 Projected views.
Once the first view is placed, Projected View become active. Add the 
Top view by moving the cursor above the view and clicking. 

Return the cursor to the Front view and move to the right to create the 
Right view. Click OK.

4 Drawing views.
Add the *Isometric view by dragging and dropping from the palette. 
Place it in the upper right corner.

Note The part document is still open. You can press Ctrl+Tab to switch 
between the drawing and part document windows.
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Tangent Edges Tangent Edges are topological edges of faces that match in tangency. 
The most commonly seen tangent edges are the edges of fillets. They 
are often made visible in pictorial views but are removed from 
orthographic views.

Where to Find It  Shortcut Menu: Right-click the view and click Tangent Edge

5 Remove tangent edges.
Using the Control key, select the front, top, and right views. Click 
Tangent Edge and Tangent Edges Removed. 

6 Display style. 

Click the Isometric view and click Shaded . In the other views, 

click Hidden Lines Visible .
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Moving Views Drawing views can be repositioned on the drawing. You place your 
pointer over the view border, then drag the view. In the standard 3 view 
arrangement, the Front view is the source view. This means that 
moving the front view moves all three views. The Top and Right views 
are aligned to the Front. They can only move along their axis of 
alignment.

7 Move Aligned Views.
Select the edge and move the Front view. It can be moved in any 
direction and the other views remain aligned.

Note Once the drawing view has been selected, it can be dragged with the 
mouse or moved with the arrow keys. The distance moved for each 
press of an arrow key is set under Tools, Options, System Options, 
Drawings, Keyboard movement increment. Use Alt-drag to select 
anywhere in the view. Use Shift-drag to maintain the spacing between 
the views while dragging.
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Center Marks Center Marks are attached to circle and arc centers in the drawing 
view.

Center marks were not inserted into the drawing 
views automatically. You can turn this option 
on or off. Set your preference using the Tools, 
Options, Document Properties, Detailing 
menu.

Where to Find It  CommandManager: Annotation > Center Mark 
 Menu: Insert, Annotations, Center Mark
 Shortcut Menu: Right-click in the graphics area and click 

Annotations, Center Mark

8 Center Mark.

Click Center Mark . 

Clear Use document defaults, check the 
Extended lines option and set the Mark size to 
2mm as shown. 

Click the large arc in the front view. Continue 
adding center marks to the two holes in the Top 
view.

Click OK.
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Dimensioning Dimensions can be created in drawing views using several tools. Some 
dimensions can be related to the dimensions generated in the sketches 
and features of the model. These are driving dimensions. Other 
dimensions are independent of the sketches and features of the model. 
These are driven dimensions.

Driving 
Dimensions

Driving dimensions always display the proper values and can be used 
to change the model. The Model Items tool imports the dimensions 
created in the sketches and features of the model into the drawing.

Driven 
Dimensions

Driven dimensions always display the proper values but cannot be used 
to change the model. The values of driven dimensions change when the 
model dimensions change. By default, dimensions of this type appear 
in a different color and are enclosed in parentheses. Here are two ways 
to create driven dimensions:

 The Smart Dimension tool manually adds dimensions to the 
model like those in a sketch.

 The DimXpert tool adds dimensions working from a datum 
position.

Introducing: Model 
Items

The Model Items tool assists in adding 
dimensions to a view or all views using the 
sketch and feature dimensions of the model.

You can import the dimensions for a selected 
feature or the entire model. It also has the 
capability to select and import different types 
of dimensions as well as many types of 
Annotations and Reference Geometry that 
may exist within the model. 

Where to Find It  CommandManager: Annotation > Model Items 
 Menu: Insert, Model ItemsNOT F
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9 Model items. 

Click Model Items . Click Entire Model as 
the Source and Import items into all views. 

Under Dimensions, click Marked for 
drawing, Hole Wizard Locations, Hole 
callout and Eliminate duplicates. 

Click OK. 

Note The position of a dimension depends on how the feature was created 
and where the model dimension was placed. Your results may vary 
from the image above.

Tip Once the dimensions are inserted, they are associated to that view and 
will move with it unless you deliberately move them to another view or 
delete them. For more information, see Manipulating Dimensions on 
page 96.
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Manipulating 
Dimensions

Once dimensions have been added to a view, there are several options 
as to how they can be manipulated: 

10 Drag dimensions.
Drag dimensions within the view to reposition them as shown.

Tip Align dimension text using the yellow guidelines. 

Drag Drag dimensions by their text to new locations. 
Use the inference lines to align and position 
them.

Hide Right-click the dimension text and click Hide 
from the shortcut menu. 

Move to another 
view

There is generally more than one view where a 
dimension can be used. To move a dimension, 
Shift + drag the dimension onto another view. 

Copy to another 
view

To copy the dimension, hold down Ctrl and 
drag it into another view and drop it.

Delete Unwanted dimensions can be deleted from the 
drawing using the Delete key. 
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11 Move to another view. 
Shift + drag the 125mm dimension to Drawing View1 and drop it. It 
will be moved from the original view to the new view. 

12 Move remaining dimensions. 
Move dimensions to reposition them as shown.
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Dimension Palette The Dimension Palette appears near your cursor when you insert a 
dimension or select one or more dimensions. It can be used to change 
the dimensions’ properties, formatting, position, and alignment.

Where to Find It  Select one or more dimensions then click 

Dimension Assist 
Tool - Smart 
Dimensioning

Use the Smart dimensioning option of the dimension assist tool to 
manually add dimensions in the drawing. These dimensions are 
considered to be driven dimensions. See Driven Dimensions on 
page 94.

13 Arrange the dimensions.

Select all of the dimensions in the top view and click  to open the 

Dimension Palette. Then, click Auto Arrange Dimensions  to 
provide better spacing and alignment of the dimensions.

Note Adjustments can be made to dimensions after using arrange. 

14 Dimensioning.

Click Smart Dimension . Select vertices 
at the top and bottom and place the dimension 
to the left of the view. 

Click OK. 
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Associativity 
Between the Model 
and the Drawing

In the SOLIDWORKS software, everything is associative. If you make 
a change to an individual part, that change will propagate to any and all 
drawings and assemblies that reference it.

15 Switch windows. 
Press Ctrl+Tab and click the part file 
to switch back to the part document 
window.

Changing 
Parameters

SOLIDWORKS makes it very easy to make changes to the dimensions 
of your part. This ease of editing is one of the principal benefits of 
parametric modeling. It is also why it is so important to properly 
capture your design intent. If you don’t properly capture the design 
intent, changes to dimensions may cause quite unexpected results in 
your part.

Rebuilding the 
Model

After you make changes to the dimensions, you must rebuild the model 
to cause those changes to take affect.

Rebuild Symbol If you make changes to a sketch or part that require the part to be 

rebuilt, a rebuild symbol  is displayed beside the part’s name as well 
as superimposed on the icon of the feature that requires rebuilding 

. Look for the rebuild icon on the Status Bar, also.

The rebuild symbol also is displayed when you are editing a sketch. 
When you exit the sketch, the part rebuilds automatically.

Introducing: Rebuild Rebuild regenerates the model with any changes you have made.

Where to Find It  Menu Bar: Rebuild 
 Menu: Edit, Rebuild
 Keyboard Shortcut: Ctrl+B

Tip The model is also rebuilt when it is saved. 

Note To rebuild all features, press Ctrl+Q.
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16 Double-click on the feature.
You can double-click on the BasePlate feature either in the 
FeatureManager design tree or the graphics area. When you do this, the 
parameters associated with the feature will appear. 

Double-click on the 125mm dimension indicated. The Modify dialog 
box will appear. Enter a new value either by typing it directly or by 
using the spin box arrows. Enter 150mm and click OK.

17 Rebuild the part to see the results.

Rebuild the part by clicking Rebuild . If you use the one on the 
Modify dialog box, the dialog box will stay open so you can make 
another change. This makes exploring “what if” scenarios easy. 
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18 Update the drawing.
Press Ctrl+Tab and click the drawing file to switch back to the drawing 
sheet. The drawing will update automatically to reflect the changes in 
the model. Dimensions may move during the rebuilding process and 
require some clean up.

19 Close the drawing. 
Click File, Close to close the drawing. Click Save All to save both the 
drawing and part files.

20 Confirm.
Click Yes to update the drawing views before saving the drawing. Save 
the drawing file in the same folder as the part. 
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Exercise 7:
Plate

Create this part using the information 
and dimensions provided. Sketch and 
extrude profiles to create the part. This 
lab reinforces the following skills:

 Choosing the Best Profile on
page 64

 Introducing: Corner Rectangle on
page 69

 Sketching on a Planar Face on page 71
 Boss Feature on page 71
 Using the Hole Wizard on page 76

Units: millimeters

Procedure Create a new mm part and name it Plate. Create the geometry as 
shown in the following steps. 

1 Sketch base feature. 
Create a new sketch on the Top plane. 
Add the geometry and dimensions as 
shown. 

2 Extrude base feature. 
Extrude the sketch 10mm as shown. 
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3 Boss. 
Create a new sketch on the top face of the solid. Add the geometry and 
dimensions as shown. 

Extrude a boss 25mm. 

4 Hole Wizard. 

Click Hole Wizard  and click the face shown. 

Click the Type tab. Set the properties of the hole as follows:

Type: Hole 

Standard: Ansi Metric 

Type: Drill sizes 

Size: 25mm

End Condition: Through All 

Click the Positions tab. Place the points as shown. 

5 Save and close the part. 
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Exercise 8:
Cuts

Use rectangles, tangent arcs and 
cut features to create the part. 
This lab reinforces the following 
skills: 

 Introducing: 
Corner Rectangle on page 69

 Tangent Arc Intent Zones on 
page 72

 Cut Feature on page 74
 Filleting on page 78

Units: millimeters 

Procedure Create a new mm part and name it Cuts. Create the geometry as shown 
in the following steps. 

1 Sketch base feature. 
Create a new sketch on the Top plane. Add the geometry and 
dimensions as shown. 

2 Extrude base feature. 
Extrude the sketch 5mm as shown. 
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3 Cut slot. 
Create a new sketch on the top 
face of the solid. Add the 
geometry and dimensions as 
shown. 

Extrude a cut using Through All. 

Tip Remember to create a closed profile by sketching the line across the 
bottom.

4 Cut another slot. 
Create a new sketch using the 
same face. Add the geometry 
and dimensions as shown. 

Extrude another cut using 
Through All.

5 Cut rectangle. 
Create a new sketch using the same face. Add the geometry and 
dimensions as shown. 

Extrude another cut using Through All.
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Exercise 8 SOLIDWORKS Education 2023
Cuts
6 Fillets. 
Add fillets of R10mm and R8mm to the edges as shown. 

7 Save and close the part. 
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SOLIDWORKS Education 2023 Exercise 9
Basic-Changes
Exercise 9:
Basic-Changes

Make changes to the part 
created in the previous 
lesson.

This exercise uses the 
following skills:

 Changing 
Parameters on 
page 99

 Rebuilding the Model 
on page 99

Procedure Open an existing part and edit it.

1 Open the part
Basic-Changes.
Several changes will be 
performed on the model to resize 
it and check the design intent.

2 Overall dimension.
Double-click the first feature (Base Plate) in the FeatureManager 
design tree or on the screen to access the dimensions. Change the 
length dimension to 150mm (shown bold and underlined below) and 
rebuild the model.
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Exercise 9 SOLIDWORKS Education 2023
Basic-Changes
3 Boss.
Double-click the Vert boss feature and change the height dimension as 
shown. Rebuild the part.

4 Hole locations.
Double-click the Ø7.0 (7) Diameter Hole1 feature and change the 
position dimensions to 20mm. Rebuild the model.

5 Center the Vert Boss.
Determine the proper value and change the dimension that centers the 
Vert Boss on the base.

Tip Optionally, you can delete the dimension and add a relations that 
centers the VertBoss relative to the base.

6 Save and close the part. 
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Base Bracket
Exercise 10:
Base Bracket

This lab reinforces the 
following skills:

 Choosing the Best 
Profile on page 64

 Boss Feature on 
page 71

 Using the Hole Wizard 
on page 76

 Filleting on page 78

Units: millimeters

Procedure Create a new mm part and name it Base_Bracket. Create the geometry 
as shown in the following steps. 

1 Sketch base feature. 
Create a new sketch on the Top plane. Add the geometry and 
dimensions as shown. 

2 Extrude base feature. 
Extrude the sketch 20mm to create the base feature as shown. 
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Exercise 10 SOLIDWORKS Education 2023
Base Bracket
3 Sketch on rear face. 
Change to the Back view orientation, select the face indicated and 
create a new sketch. Add the geometry and dimensions as shown. 

4 Extrude boss. 
Extrude to the sketch 20mm as shown. 

Select Face
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SOLIDWORKS Education 2023 Exercise 10
Base Bracket
5 Fillets. 
Add fillets to the edges as shown. 

R20mm

R25mm

R12mm
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Exercise 10 SOLIDWORKS Education 2023
Base Bracket
6 Hole Wizard. 

Click Hole Wizard  and click the face shown. Click the Type tab 
and set the properties of the hole as follows:

Type: Hole 

Standard: Ansi Metric 

Type: Drill sizes 

Size: 20mm

End Condition: Through All 

Click the Positions tab and locate the holes as shown. 

7 Second hole. 
Repeat the procedure to create an 18mm hole on a different face as 
shown. 

8 Save and close the part. 

Select Face

Select Face
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Part Drawings
Exercise 11:
Part Drawings

Create this part drawing using the 
information provided. 

This lab reinforces the following 
skills:

 New Drawing on page 88
 Drawing Views on page 89
 Center Marks on page 93
 Dimensioning on page 94

Procedure Create a new drawing and add the views and dimensions shown in the 
following steps. 

1 Open part.
Open the part Basic-Changes-Done.

2 New drawing.
Use the Make Drawing from Part command and the 
B_Size_ANSI_MM template to create the drawing views as shown.

3 Dimensions.
Add the annotations and dimensions as shown.

4 Save and close all files. NOT F
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